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7.2 Form

(1) Introduction to Form

(2) Creating Forms

B ©-2- = Access Vattanan Naiyapo

Home Create External Data Database TOMS/Q"PE‘H'M'!W todo
By ﬂ D Rl Form Wizard !
s EE M RE AE

== ) Navigation ~
Application = Table Table SharePoint Query Query Form Blank
Parts ~ Design  Lists~ Wizard Design Design Form More Forms ~

Templates Tables Queries
| ]

& O

HJeport Report Blank L:
Design Report E ‘

Reports

Forms
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(1) Introduction to Form

Microsoft Access provides many tools for the user to more
conveniently manage data, such as entering/changing/deleting data.
In this chapter, we will focus on one of these tools: Form, a tool that

will help user enter and change data on the table.

We will learn how to create a work with Form
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(2) Creating Forms

File Home Create External Data Database Tools Design Q Tell me what you want to do
& l ------------- Ny
- —il Form Wi ; = — .
e M REEE R 5 & [ R
e SN e s Navigation~ |

Application = Table Table SharePoint Query Query = Form Form Blank Report Report Blank Labels

Parts ~ Design  Lists~ Wizard Design I Design F [E More Forms ~ I Design Report

Templates Tables Queries I ( Forms > 1 Reports

I ] [ ——— g ————

Creating a Form can be done in multiple ways with commands in Design tab —>
Forms group

(2.1) Form create a default, one-record-at-a-time form.

(2.2) More Forms - Multiple Items create a form that you can see multiple items at
the same time.

(2.3) More Forms - Datasheet create a form that display all data in data sheet view

(2.4) More Forms - Split Form create a form that provide both one-record and
datasheet view together

(2.5) Form Wizard create a form with a wizard. User can easily create a form

following a step-by-step guide.
(2.6) Blank Form create a blank form that you can customize as you wish
(2.7) Form Design create a blank form in Form Design View
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(2.1) (Default) Form

Example: MyStudent database with Student table
(2.1) Creating a default from
1) Click Create tab

2) Click Form icon 1). 2)@ ] @Forr.nw.izard
— l"-.larl.-'lgﬂtl»'Jr1v
3) Default form will appear I FHome B Form  Blank

Design  Form More Forms -

Farms

Default form will only show one record at a time, with all fields

presented = Student - (m] x
E Student
¥
TSNS T oo o oo
3) . idStudent :1_59051 234 f
title |u':t|
firstlame |lﬁﬂ'iﬁ
lastName |r|';an
address |?7 17 aduiida adas adinens
We are at 15t record, oea [31
out of 5 total record allowance  [1500
~<~ R R e
— | n
Record; 4 ({1 of 5 Y b ¥ v | E o Fiter | [Search | [«] [
~ % Next record

MAIYIINYINISADUWILODS Create a new record
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(2.2) Multiple Items

1) Click Create tab

2) Click More Form icon to exparzl the list
3) Click Multiple Items

4) Multiple Items form will appear

B (')1). Access

Home Ex'l:emal Data Database Tools Q Tell me what you want to do 4) .

EE M RE BEEDORemw :
— == ) e, B = 3 Navigation ~ E=] Student
Application  Table Table SharePoint Query Query Form Forn = Report — = e e = e i
Parts ~ Dalgn Lists ~ Wizard Dslgn Desig 2) ™ a More FOer ¥ Tssos1234 e \itrsd g 7707 adufida o ufiae ifaenn 31 1500
Templates Tables Queries H
. 3) u :g Mﬂltipl e ltems 59051281 wnam nt nanin fii .:'-'.3‘3.‘.',‘1““""1“ aulaaa 25 2000
AI | AC C eSS O b ects @ « BB T wHaT Ao i 56305 i adlas aadeelai [ 2500
500
} Tables a @ Dgtasheet | Tso081599 A Wi nndl 89/7 auuindlas audlas 3iduslwi 2 1800
Z5 student i
i 60051234 i dns Ty 125/6 ouwsatyl avlas ndww 29 2200
% Split Form ]
Modal Dialeg T T DT AT | E
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(2.3) Data sheet

Similar to Multiple Items form, but will always show all fields

H ©-¢ Access
1) Click Create tab Home ‘External Data Database Tools Q Tell me what you want to do
. T Ko R i ;
2). Click More Formsvto expand o) E & M Iﬁ E == L

. R (& Navigation ~
. Application = Table Table SharePoint Query Query Form F . Report
3)_ Click Datasheet Parts ~ Design Lists~  Wizard Design De 2) IE More Forn€-)
Templates Tables Queries

4). Datasheet form will appear All Access Objects @ «

- Multiple ltems
Tables R 3)' < % Datashe
E5 student N

--- ==| Split Form

Modal Dialog

dStudent - | title - |firstName - | lastName - | address - GPA -]

| EEEER  ww fes man 777 adwddo odos iy 31 150
4) . 1558051281 wnd T snovlwn 55 1. 3 ouwninfios o.dflos 2. iwwae 2.5 200
Jsgum 281 wwAm  Umiwn ol 56 1.5 melmwnu aaflos 38w 5019 250
|5806159%  wwanm Wi Tt 89/7 nuuwmindloe oaflos sududlml 2 180
:[51]051234 w ing trynni 125/8 ruwsnid auflos .dmu 29 1220

* ] 0
Record: M 4 [1ofS | » M0 | T NoFiter [[searcn | [[4] | i
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(2.4) Split Form

With this, you can see single item form and datasheet at the same time.

E‘D'C)'=1 Access

1) CIiCk Create tab Home 7 External Data Database Tools Q Tell me what you want to do
2) Click More Forms Vto EE D RE Eg 0Oz

- . ™3] Navigation =
Application Table Table SharePoint Query Quel Form Fon = Repo
expand P‘p:artst, Design  Lists~ t Wizar::l Dgsi:r: Desit 2)l £] More For"@ port
Templates Tables Queries rorm E Multiple Items
3) Click Split Form All Access Objects ~ © « =
- . ables £ | @ Datasheet
4) Split Form will appear = student

3).(&E
Modal Dialog

= 7] Istudent n

4)..

idStudent [591::51?34

title |'u.‘|u

firstame |ﬂ1u-pj

lastName ||"|‘[I'|.1'1

| address |77 w7 wdufiko aufies sl B j‘

3 T —1 ¥
wdStudent. - | title - firsthami - | JastName - | address =10 Gea |3
59051234 ww R man 7afameidecdeades 310 L

(50051281 wwam A Inarvin 55 u. 2 nuullies o.fes i 2.5

59061281 wwAm dwmown el 56 15 sudnru oudlos wsffedu 50 19 =
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(2.5) Form Wizard

Form wizard helps user easily create a form by providing step-by-
step guide. To use the wizard:

1. Follow these steps
1.1 Click Create tab
1.2 Click Form Wizard

H ©-¢& 1.1 Access

Home External Data Database Tools Q 1.2 iat you want to ¢
I = — "

— Bl p= { G& Form Wizard

EE M R& B N N

Application = Table Table SharePoint Query Query Form

Form Blank
Parts ~ Design  Lists~ Wizard Design Design Form More Forms ~
Templates Tables Queries Forms
Tables ® «

=+ Student
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2. Form Wizard dialog will appear, do the following:
2.1 Click [7] to select data source. Table:Student, in this case.
2.2 Select the fields you wish to be on the form
(Click field = click | > = or double click the field )
Or, to select all fields, click >>
In this example, we will put all fields in the form
Button [ > | Add field (s) from Available Fields to show in the form
Button < << remove selected field(s) from the form
2.3 Click Next

Form Wizard
Which fields do you want on your form?
= > : ¥ou can choose from more than one table or query.

Form Wizard

Tables/Queries Which fields do you want on your form?

:I:EEl_E'_étl..ld-E-rl-t B e | 2 1 i » £ You can choose from mare than one table or query.

1 ' L . 2
Tables/Queries

Available Fields:

Selected Fields: [Table: Studznt El

Available Fields:

title
firstMame
|zstMame
address
GPA
allowance

2.2

— - s -]
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(2.5) Form wizard (cont.)

3. Next, we will be ask to select a layout for the form, do the followings:
3.1 Select a form layout. In this example: Columnar
(Preview of the layout will appear on the left)
3.2 Click Next

Form Wizard
What layout th?
@FColumnar N
(OTabular
OE_)atzsheet 3 . 1
O ustified
| cancel || <Back || (next>) || Einish
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(2.5) Form Wizard (cont.)

4. You will be asked to name the form, do the following:

4.1 Type in the form name. In this example: StudentForm

4.2 In the option, click Open the form to view or enter information
4.3 Click Finish

Form Wizard

What title do you want for your form?

| _(_,‘cﬁ |StudentForm| 4 . 1

[ That's all the information the wizard needs to aeate your
form.

Do you want to open the form or modify the form's design?

4 . 2 (® Open the form to view or enter information.
(O Modify the form's design.

CalRR 4.3

| cancel || <Bak | mext> || @nsh |
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(2.5) Form Wizard ( cont. )

5. The result, StudentForm form will appear

== StudentForm - | x
StudentForm
]
idStudent m
fitle Uulg
firstName |lﬁﬂ"iﬁ |
lastName |ﬂ‘l:ﬂl."| |
address 77 w7 adudiida aias s
GPA | 31|

ailléswiine 1500]

Record: 4 «[10f5 | » b ¥ I°E noFilter | [Search |

® The status bar of the form is showing that the Student table 5 records, with
the first one being active

® We can : view data, edit data, and add more data
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(2.5) Form Wizard ( cont. )

= StudentForm - | W
StudentForm
[}
idStudent m
fitle Ul
firsttName |Iﬁ£|‘iﬁ |
lastMName |ﬂ‘§ﬂl."| |
address |?? U7 aAuditda aiias 3.1hiae5n
GPA | 3.1

allowance 1500

Record: 4 4 [1of5 | » M b [ E NoFilter | [Search |

Go to first record

Go to next record
Go to previous record Go to last record
—— Create a new record, record 6 in this case
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(2.6) Blank Forms

A blank form will be created, where we need to manually add fields
into it
1. Do the followings:

1.1 Click Create tab
1.2 Click Blank Form

H ©-¢&- Access

Home - External Data Database Tools 1. 2 e what you want to «

-l Form Wizard
? Do M BRE EEOg--
5| Navigation ~
Application  Table Table SharePoint Query Query Form Form \ Blank
Parts ~ Design  Lists~ Wizard Design Design [ More Forms -
Templates Tables Queries Forms

Tables @ «
[_@ Student
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(2.6) Blank Forms (cont.)

2. Blank form will appear, we need to add fields

i ; ; X
2.1 Click Show all tables Flold Lick
List of all tables in that database will appear No fields available to be added to the current
2.2 Click + in front of a table to expand B @onanenisy 2.1
Field list will appear, and we can choose
_ ] . Field List
WhICh fleld WI" be added to our form E Show only fields in the current record
Form1 - o X Eialds available in other tables:
> [2] udent Edit T:
2.2 @ idStudent
title
firsthame
2 lastMame
address
GPA
allowance
B
0 ] . Add Existing |
If field list does not show, Fields
= click Add Existing Fields
Record: 4 <[1of1 | » M+ | T NoFilter |[Search [[«] Hoh
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(2.6) Blank Forms (cont.)

Click & drag a field to the form

HastName |Agat
;uddress 77 317 adufilda adlag anaess

idStudent (59051234 |
 fitle |u1ﬂ |

! firstName |lﬁ£l‘iﬁ |

lick&drag

Field List

E’ Show only fields in the current record source
Fields available for this view:
= Student

idStudent

title

firstName

lastMame

LI

address
GPA

Record: W < [10f5 | » W | B Mo Filter ||5earch |

| 1 I
;| +address I A

ext "I'ezt'box:
The data

Label :
accompanied the
data
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(2.6) Blank Forms (cont.)

Save Form : BlankFormStudent

BlankFormStudent — O Y

Id5tudent |B
title

firstName [fiasd

lastMame |[Agmn

=1 = =
address 77 ALdauslEa aliladg .0 nE-a91E

Record: 4 «[1ef5 | » » | T NoFilter |[Search
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(2.7) Form Design

Also will create a blank form, but we will start in Design View, where
we can change how the form will look

1. Do the following:

1.1 Click Create tab
1.2 Click Form Design

H ©- C)'1= Access

Home External Data DatabaseTooii 29 Tell me what you want to do

[ - & Form Wizard

— - - -3 Form Wizar —
HE M RE &

Navigation ~

Application = Table Table SharePoint Query Query Plank Repo
Parts ~ Design  Lists~ Wizard Design orm More Forms ~
Templates Tables Queries Forms
All Access Objects  © « Form Design
Tables A Create a new blank form in Design
view.
r@ Student ]
Forms 2 In Design view, you can make
= advanced design changes to forms,
E=]  BlankFormStudent such as adding custom control
StudentForm types and writing code.
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(2.7) Form Design (cont.)

New tab will appear

2. Click Design tab

3. Click Add existing Fields

4. Click and drag fields to the form

B - = Access Form Design Taols | Maiyapo 7

“ Home Create External Data Dmbw:Toq< | Design >.hruﬂg= Format Q Ta mewhatyavinttodn

-_&EI nﬂulnm'

View | Themes Funisv

] -1 =] i Logo &
38 A= (1@ B EE,,, D EINE B
: ¥ ng fProperty Tab

z Image - B3 Date and Tim | Fields | Sheet Order &

Views Themes Contrals

Header f Faoter Taals
Form?
All Access Ob...® « ~Field List
Tables - ?
B0 student ' B Ezmonlrﬂelds i
— .

Fields available for thisy
BlankFormstudant

E StudentForm

firstName

lastMame
| address.
..... Gpﬂ
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(2.7) Form Design (cont.)

It can take a little while to adjust the form’s look
to your likely, you can:
Drag the corner to change the form size

B ©-¢- = Access Form Design Tools

- Move field Home Crate cemalData  DatabaseTools | Design  Aminge | B
- You can select multiple fields by IY [frsthiare al Ui (¥ |[Formateing - =
shift and click e \-‘-‘- O[T § W2 [
Seledtion Font Number Background
- In Format tab, you can change ol . B

® Font color/typeleffect

® Background color ,

- You can change a particular by clicking it and |
make the change

Label : || Textbox : o
24aAU || : AaYA
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(2.7) Form Design (cont.)

Click Save to record the change
Let’s name this one FormDesign
5. To view the resulting form:

5.1 Click Home tab

5.2 Click View to expand the list

5.3 Select Form View

5.4 You will see the form

8 Create External D | e FormDesign

W 4l Ascending

Zl Descending 1edStudant

Paste ,  Filter [59{151234 |
5 . 2 v d 7 Remove So _
5 l Sort & Filter Ie] ] -
5.3 iﬁm ':,) « fstNome  1AU9A
-+ Datasheet View A et iome I"‘*““ J
A wdsiome 7 0.7 afuida oo 9.
Layout View ~ PR
NI
bA/ Design View
crem

Record: M. 4 [1o15 | ¢ w ko | T NoFilter | [Search |
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(2.7) Form Design (cont.)

Form Components

- Form Header

Form Header

- Page Header

- Detail || ¢ peta . Page Header

- Page Footer

- Form Footer

TR ERTEE FIETE Detail
lastName

Page Footer

| Form Footer
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(2.7) Form Design (cont.)

You can adjust the look of existing form as well by:
At the navigation pane
1. Select Forms to show all forms

2. Double click to select the form you want to change, FormDesign for example

The form will be opened

Forms < _

1 . Navigate To Category =] FormDesign - O r

Custom »

Object Type

Tables and Related Views

Created Date m |

Modified Date
firstMome ||-ﬁ£l‘!iﬁ ]

1dStudent |5g.a.51234 |

Filter By Group

Tables Forms © « lostName l“'i"m |
</WK BlankFormStudent add’rﬂ:s ?? u.? a ﬁuﬁl‘jﬂ i]‘i,i.ﬁ}ﬂ 2
%szhmoesign ) . s

Reports

StudentForm o
All Access Objects Record: 4 < [1of5 | » » » | ¥ o Filter |[Search |
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(2.7) Form Design (cont.)

3. Click Home tab
4. Click View to expand the list
5. Select Design View

The design view of the form will appear

FormDesign
. || # Detail

D [‘@ Copy
4. < o > o % Format Painte -
‘ - Form View
¥ «

EE- Datasheet View

[— =] .
E Layout View
[— =]

A
. = B
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(2.7) Form Design (cont.)

6. Click Detail &l FormDesign - 0o %

7. Right Click and enable N N T SR S S R

| || % Form Header

- Page Header/Footer i
|| # Page Header

- Form Header/Footer

Those components till appear in the form

8. You can resize a component by click -
and drag at the corner = Bt .
FormDesign “
1 ! ok '
2
Build Event... i . !
23 Tab Order... Ik :
By Paste ‘— =
& Fill/Back Color v | W& eage Foctss
EH  Alternate Fill/Back Color  » = I_.. 8
Buler -. L-;'FurmFunter : i

| Grid

Page Header/Footer
k2l Form Header/Footer

[E] Eorm Properties
[E] Properties
] B R
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B -2~ = Access Form Design Tools

. Home Create External Data Database Tools Arrange Q Tell me what you wan
In Design tab

Logo
E nCc»lorsv &~ -0g %B
[ ] H H .

CIICK iIcons View Themes [I]Fonts- % (@ Aa - Ij % - E sert D) Title ) Add Exisl
- - age~ t"-c-'-) Date and Time Fields

- Logo y add |OgO Views Themes Controls Header / Footer,

\ —— N~

- Title : Add title to form FormDesign — & &

- Date and Time (][ 5 @5 %5 w3 75 0 #6 Fgw 50 @b GB s B0 b g Wh G0 G pa

|
_| | % Form Header

Will appear at the Form Header

Furthermore, we can add other objects

from Ribbon Controls such as labels

and images

In Format tab

You can change fonts, add color,

etc.

_| | & Page Footer
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(2.7) Form Design (cont.)

To view the result:

] . . =) FormDesign - ] X
Click View — Form View Formdosin Fraa e 20T
. : 30340 PM
1 3

1dStudent |59|]51 294 ]
. Home Crea ﬁf(:e;_q |u 1

&_D Efg-(éut firsttame |lﬁﬂ1'ﬁ ]
@' Paste % opy IG&‘INDH‘IE E"-.imq ]

&
. ¥ Format

e oddress e
A:i , > ! 77 0.7 a.#uiida .20 3.
E Eorm View | Fr '

ravuy

bu/ Design View
[oescmn

Record: M < [10f5 | » » »0 | T noFilter | [Search |
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